# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>5</td>
</tr>
<tr>
<td>Scope of This Manual</td>
<td>5</td>
</tr>
<tr>
<td>Features of LXVII</td>
<td>5</td>
</tr>
<tr>
<td>System Requirements</td>
<td>6</td>
</tr>
<tr>
<td>The Calculator Window</td>
<td>7</td>
</tr>
<tr>
<td>Preferences</td>
<td>9</td>
</tr>
<tr>
<td>Calculator Settings</td>
<td>9</td>
</tr>
<tr>
<td>Documents Settings</td>
<td>10</td>
</tr>
<tr>
<td>Paper Tape Settings</td>
<td>10</td>
</tr>
<tr>
<td>Document Format</td>
<td>12</td>
</tr>
<tr>
<td>Menu Commands</td>
<td>13</td>
</tr>
<tr>
<td>The LXVII Menu</td>
<td>13</td>
</tr>
<tr>
<td>The File Menu</td>
<td>13</td>
</tr>
<tr>
<td>Edit Menu</td>
<td>15</td>
</tr>
<tr>
<td>View Menu</td>
<td>17</td>
</tr>
<tr>
<td>Known Problems</td>
<td>18</td>
</tr>
<tr>
<td>Acknowledgments</td>
<td>18</td>
</tr>
<tr>
<td>End Notes</td>
<td>18</td>
</tr>
</tbody>
</table>

* LXVII User's Manual 3
Introduction

LXVII (pronounced “67”) is a calculator application for Apple’s Mac OS X. Its name comes from the Hewlett-Packard HP-67 calculator on which it is based. It is the calculator pictured in the application icon, and the cover of this manual. This program is in large part a homage to the work done by Hewlett-Packard in developing the HP-67, a calculator that is still a pleasure to use, almost 30 years after its introduction.

LXVII was conceived with 2 objectives in mind. The first was to provide Mac OS X (and thereby me,) with a simple and powerful Reverse Polish Notation (RPN) based calculator. I know there are a lot of RPN calculators out there, but simple and powerful seem to be mutually exclusive features for most of them (no offense to the authors, who probably feel the same way about LXVII). The second goal was to serve as the means to learn Apple’s Cocoa application framework and the Xcode Integrated Development Environment (IDE).

I believe that developing LXVII has met both goals. I hope you will agree about its usefulness. I know that it has served to introduce me to most aspects of code development using Cocoa’s Foundation and AppKit frameworks.

Scope of This Manual

This manual will describe the features of LXVII and will list the differences between its operation, and how it differs from the original HP-67. It is not meant to be an introduction to the HP-67's functionality. If you want to learn about the HP-67 and more generally how to use RPN based calculators, an excellent place to start is <http://www.hpmuseum.com/>.

An excellent tutorial to RPN can be found at <http://www.hpmuseum.org/rpn.htm>.

The HP-67 information is found at <http://www.hpmuseum.org/hp6797.htm>.

Features of LXVII

The major features of LXVII are listed in the Readme.pdf file distributed with the program. They are repeated here for convenience.

• A faithful representation of the HP-67, including its familiar keyboard layout.

• All buttons have keyboard equivalents via hot-keys and are self-documenting via tooltips.

• All the programming features of the HP-67 are supported. Program compatibility has been preserved as much as possible, so the original HP-67 program libraries can be run with minimal or, ideally, no modification.

• LXVII is a document based application, which means you can have multiple calculator instances running at the same time. By extension, each document essentially becomes a custom calculator suited to a particular task.
• Since multiple calculators can be active simultaneously, it means multiple programs can be run simultaneously. LXVII takes full advantage of Mac OS X’s multi-threading features, utilizing multiple CPUs as needed.

• In addition to the calculator state being saved as a document, the program and data memories can also be saved and reloaded as separate documents. This is analogous to having data-only magnetic cards, or programs that span multiple cards.

• Enhanced HP-67 features:
  - Better precision: All operations are done using double precision numbers, yielding a range of -10E-320 to 10E+320 (or thereabouts) with 15 digits of precision.
  - Live display of vital registers including: the stack, the lastX register, the current programPC, the memory registers and the program memory. These become very handy when you need to debug a program.
  - Mode settings are always displayed. Mode settings include angle settings and display notation.
  - Paper tape output with vertical and tab-delimited mode for importing into a spreadsheet program.
  - The five soft keys can be labeled and assigned tooltips.

System Requirements
LXVII requires the following to run:

• A Macintosh that is capable of running Mac OS X 10.3 (Panther) or later operating system.

This requirement is specified because earlier machines and operating systems could not be tested.

LXVII is a Universal Binary. It runs natively on Power-PC and Intel based Macs. Because Universal Binaries require Mac OS X 10.4 (Tiger) to run, it is distributed in 2 versions:

1. A Power-PC version that will run on Panther and later capable systems (LXVII).
2. A Universal Binary version that will run on all Tiger capable systems (LXVII Universal)
The Calculator Window

Figure 1 shows the Untitled calculator window that is created when LXVII is first executed. Anyone familiar with the HP-67 will instantly recognize the familiar layout. Note however that it does not look exactly like an HP-67; it looks (I hope you’ll agree,) like a Mac OS X brushed-metal application. LXVII is not an HP-67 emulator: Emulators attempt to be feature-for-feature and bug-for-bug compatible with the original application or device, sometimes going so far as to use the original application code or ROMs and executing them with a virtual machine.

![Figure 1](image)

By contrast, LXVII is an original application that just happens to provide the functionality of the HP-67. It is not, and does not attempt to be 100% compatible with the original device. The best example of the differences being that, all calculations are done using 64-bit floating point numbers rather than the HP-67's 10-digit Binary Coded Decimal (BCD) format.

Beyond the obvious “Mac look” there are 2 functional differences between LXVII and the HP-67 layouts: The small “DEG” legend within the dark-red display area, and the “REGISTERS” button where the normal ON/OFF switch should be.
“DEG” denotes that the calculator is degree mode as opposed to radian or gradian modes when it executes trigonometric functions.

The more interesting feature is the “REGISTERS” button. Clicking it will display a drawer with the RPN stack as well as it’s memory registers and program memory. Figure 2 shows the drawer with the memory display. Figure 3 shows the program memory.

All registers are live, in that any operations that affect the visible registers will be shown as they happen. The exception to this rule is in the case of a running program. In that case, in order to avoid program slowdowns, LXVII only updates the register displays when the program executes an operation that causes the numeric display to be updated. This includes the “PAUSE”, “SPACE” (print space), “−x−” (print x), “STK” (print stack) and “REG” (print registers) commands.

All registers and memory locations can be edited directly either via the keyboard or the Edit menu functions. The exception is the program memory, which can only be modified via the window button functionality. It is possible to change the program PC by selecting the desired row in the Program view pane.
Preferences

This section lists all preferences and describes their functions. The main preference window has 3 tabbed views and 3 buttons that apply to all views. Figure 4 shows the Preferences panel, with the Calculator tab selected.

![Figure 4](image)

The three buttons below the tabbed views affect all 3 panes, not just the one that is visible.

1. “Defaults” resets all 3 pane settings to “factory defaults”, that is the settings that are in effect when the program is first run.

2. “Cancel” reverts all settings to what they were before the “Preferences” menu item was invoked. This includes any color changes that have been made to visible calculator windows.

3. “Ok” causes all settings to become active.

**Calculator Settings**

The “Calculator” pane shown in Figure 4 allows you to set the color of the numeric display. By default, it is set to approximate the HP-67’s red LED display, but it can be set to anything you like. Clicking any of the color wells on the left will bring up a color chooser that will let you choose a color for the desired part of the display. Any calculator that is being displayed will display the new setting “live” so that you can see what it will look like.

The 3 samples on the right are some typical settings you may want to try. Clicking the sample will choose that color scheme.
DOCUMENTS SETTINGS

The “Documents” pane allows you to select how the LXVII treats documents on startup and quitting. Figure 5 shows the options available.

![Figure 5](image)

The “Startup” setting defines how LXVII first startup. “Create new calculator” starts the program with an “Untitled” blank document. It’s akin to powering on an HP-67. “Use last calculator” starts the program with the last calculator document used, with all registers intact. If the document does not exist for some reason, it will start with an “Untitled” document as above.

The “Quit” setting defines how the program treats open document when it is quit. It defaults to “Ask”, which implements the standard behavior for Mac document based applications. If a document is modified, (that is, if any registers, memory locations or program steps have been modified from their initial contents,) you will be asked if you want to save it. This is the safest setting, but it can get very annoying if you use the calculator for lots of small calculations and quit between each iteration.

“Always save” as it's name implies save any documents that are modified without asking. While this may seem to be a safe setting, be careful about saving program documents that have been accidentally modified. A good habit to get into is to lock documents you don't want to accidentally overwrite.

“Never save” discards any changes made to modified documents. Obviously this has great potential for losing changes you want to save. The best way to avoid losing data in this case is to save often. (Always a good rule, no matter the program.)

PAPER TAPE SETTINGS

The “Paper Tape” pane allows you to select how the LXVII paper tape mode looks and behaves. While the HP-67 does not have a paper tape, LXVII implements the paper tape behavior that of its close cousin the
HP-97 desk calculator with one notable exception: While the HP-97 only allowed for vertical printing, LXVII provides a tab-delimited mode that can be used as a way to generate data for spreadsheet programs.

Figure 6 shows the options available.

![Figure 6](image)

The “Output Format” options allow you to modify the background and text color of the paper tape display. The “Use tab-delimited output mode” implements the following behavior:

If the option is disabled a new line is added to each number after it is printed.

If the option is enabled each number except the first of each line is prepended with a TAB character. If you wish to start a new line, use the print space (SPACE) command.
Document Format

LXVII uses its own internal document format. The document can have either a .lxvii suffix or extension. Figure 7 shows the document icon for a document.

![Document Icon](image)

*Figure 7*

A LXVII document consists of the contents of all the data registers, memory locations memory flags and program steps that were active at the time of the save. It does not save the numeric display or paper tape settings, since they are application-wide.

The file is saved in a binary format using Cocoa archive/restore functions, rather than a more open XML format. The format may change to XML in a future release.
Menu Commands

This section describes the menu commands implemented by LXVII. For brevity’s sake, it won’t cover the obvious commands common to most document based Mac OS X programs.

The LXVII Menu

The main program menu implements the usual Mac OS X functions, including About, Preferences, hiding variations and Quit.

The File Menu

Figure 8 displays the LXVII File menu. The darkened options are have the expected behavior of most Mac OS X applications. This section will only describe the commands that are specific to LXVII.

1. Load Card File...

   Load Card File... reads data files created with Save Program... and Save Memory... for the memory registers or program memory as appropriate. The read data is merged into the current document, which remains active. This function is meant to be used to process different data sets with the same program or to chain multiple programs together when they do not fit within the 224 step memory space.

   This function uses data inside the file to determine whether the file contains memory data or program steps.

2. Save Program...

   This command writes the program steps to a file. Note that it does not save the current document, and it retains its modified setting. Files created with this command are meant to be read back in with the Load Card Data... command.
3. Save Memory...

   Similar to the *Save Program*... command this function writes the memory registers to a file for later reading with the *Load Card Data*... command.

4. Print Paper Tape...

   This command invokes a standard Mac OS X print sheet and allows the user to print the data on the paper tape. Note that it prints using the color preferences selected for the paper tape. The menu option is enabled only when the paper tape panel is active.

5. List Program...

   This command is analogous to the *Print Program* command in the HP-97 desk calculator. It displays all program steps from the first non R/S instruction to the last.
EDIT MENU

Figure 9 displays LXVII’s Edit menu. Note that while only one command is specific to LXVII’s functionality, the normal Mac OS X edit commands are active when the register drawer is opened, and a data item is selected.

![Edit menu screenshot]

Figure 9

The Set Key Labels... command displays a sheet panel that allows the user to label the top row of keys of the calculator with a functional mnemonic and an associated tooltip message. Both the buttons and the secondary “f” text can be labeled. This functionality can best be described using some examples. Figure 10 shows the default sheet contents for an unprogramed calculator.

![Set Key Labels sheet panel]

Figure 10
Figure 11 displays the top row labels for the above settings.

![Figure 11](image1)

Figure 12 shows the sheet contents for the keys labeled by the primes program that is distributed with LXVII.

![Figure 12](image2)

Figure 13 shows the top row labels for the primes program. Note that in practical terms, the button label is limited to 3 characters. Longer labels are clipped by the button.

![Figure 13](image3)

Note the 3 buttons in the lower left.

- **Clear** - Clears all legend and help fields.
- **Defaults** - Resets all fields to the contents of an unprogrammed calculator, as shown in Figures 10 and 11.
• **Revert** - Similar to Cancel, it resets any changes made to any field contents since the sheet was invoked, but it does not dismiss the sheet.

**VIEW MENU**

This menu contains all other LXVII specific commands. Figure 10 shows all options in their enabled states.

<table>
<thead>
<tr>
<th>Show Paper Tape</th>
<th>ST</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Registers</td>
<td>SR</td>
</tr>
<tr>
<td>Program Mode</td>
<td>SM</td>
</tr>
</tbody>
</table>

*Figure 10*

1. **Show/Hide Paper Tape**

   This command toggles the paper tape window for the front-most calculator window.

2. **Show/Hide Registers**

   This command is analogous to clicking the *Registers* button on the display. It slides the register drawer to the side of the main window. This command is provided as a convenient keyboard-based shortcut.

3. **Program/User Mode**

   This command is analogous to toggling the *W/PRGM-RUN* slider on the main display. It switches between calculation and write program modes. This command is provided as a convenient keyboard-based shortcut.
Known Problems
A list of known problems and wish-list items is in the Readme.pdf file distributed with LXVII. That file is kept more up to date than this document, and should always be checked when a new version of LXVII is released.

Acknowledgments
LXVII uses Robert Harder’s ThreadWorker class to implement multi-threaded program execution. I appreciate Mr. Harder’s placing the class into the public domain, and look forward to being able to make a similar contribution to the Mac programming landscape.

End Notes
LXVII was produced as a vehicle to learn Mac OS X programming using Apples Cocoa Programming framework and Xcode development environment. Development began on Mac OS X 10.3 (Panther) and continued to 10.4 (Tiger).

Most development was done very comfortably on a 12-inch, 1-Ghz iBook G4 with occasional use of a Dual 2-Ghz G5.

This document was produced using Apple Pages on a Dual 2-Ghz G5.